Appendix A - Sample Exercises
This appendix gives you a series of exercises to try out as you progress through the PRS manual. Detailed instructions for each task are not given here but, at times, some useful hints are given. If you feel you need more detailed information, you can return to the chapter which relates to the exercise and read the relevant sections again.

Copies of the exercises are also available on the "PTR1 User's Guide" CD in the folder called "PRS\Sample Projects\Documents".

It is hoped that you will find the exercises to be a useful addition to the manual and that they help you to reinforce your understanding and enjoyment of the product as you learn.

Exercise 1 - Configuring PRS
This exercise will give you practice at configuring the PRS software including the Voice Guidance, the display settings, Default folder for recording and selecting a CDR or CDRW drive.

a. First of all you need to launch your PRS software. Go ahead and do this now. Remember that you can either use the "Plextalk Recording Software" icon on the Desktop or by selecting it from the Windows Start Menu

When you get to the first dialogue box, select "New" from the list and then press "Enter" to accept the suggested recording format. At the next dialogue, just enter a simple folder name and press "Enter". Press "enter" again to accept the creation of the temporary folder. One final press of the "Enter" key will allow you to bypass the book information for now, leaving you in a new empty project.

b. Once in the software, try turning off and on the Voice Guidance feature. (Hint: "Voice Guidance" on the "Option" menu). Double check that you have succeeded by trying to navigate the menu system or main screen. If you have turned off the Voice Guidance, also note that the "F12" and "F9" keys have no effect.

c. Before trying the next task, you will have to make sure that you have turned on the Voice Guidance following the previous one. Set the voice to be "Mary" with a pitch of 200, speed of 150 and volume of 100. (Hint: try selecting the "Selection of the TTS engine" option on the "Option" menu). Once you have successfully managed to alter these settings, reset the voice back to its original settings by using the "Default" button.

Finally, go back to the same dialogue box and select a voice that you wish to keep as your default voice. Set the pitch, speed and volume to suit your preferences and save the settings.

d. Now try adjusting the list and message fonts. Have a go at changing both of these settings. (Hint: Try the "Option" menu and look for "List font size" and "Message font size"). Try setting these to the largest and smallest option offered and see how this affects the on screen information.

e. The next task is to set up a default folder for all your PRS projects. By using the "Select folder" button in the "Recording Function" dialogue box, now go ahead and try to set up a completely new folder in your "My Documents" folder which is called "PRSProjects". (Hint: You can access the "Recording Function" dialogue box from the "Recording" option on the "Option" menu. Remember to select the parent folder and then press the "Add New Folder" button before typing in the new folder name).

f. The last task in Exercise 1 is to select a valid CDR or CDRW drive for writing to later on. Go ahead now and try to set up your preferred drive as the default drive for the PRS software. (Hint: Try selecting the "CDR Drive" option from the "Option" menu).

If you had difficulty with any of the tasks, try reading Chapter 6 again.

Exercise 2 - Opening projects and CD books
This exercise aims to give you practice in opening existing projects or books and creating new blank projects. Before starting this exercise, place the "PTR1 User's Guide" CD in your CD drive.

On the CD there is a folder called "PRS\Sample Projects\Samples" which contains 5 versions of the same project in different stages of production. The folders are called "AfterBuild", "BeforeBuild", "DistributionCD", "MasterCD" and "Synthesized". Before starting this exercise, you may find it useful to browse this folder and familiarise yourself with the files in the various locations. You will probably note that many of the folders have similar files but there are important differences. These will be highlighted during this exercise.

a. Opening an existing project. Try to open the project in the "Samples\BeforeBuild" folder. You can either do this as you launch the PRS software by choosing "Open" from the initial dialogue box or by using "Open" from the "File" menu. (Hint: You are looking for a file called "NCC.IMDN" because you are looking for a project file not a finished book file).

You can confirm that you have successfully opened the project by pressing the "Left Arrow" key. You should hear the words "Bogmoor Amateur Athletics Club" spoken.

b. Creating a new project. Having successfully opened the existing project, you now decide to create a new project altogether. Without exiting from the PRS software, try to create a new project and call it "TestProject1". Remember that, if you have created a default folder earlier, your new project will be saved into this folder unless you specify a different location. (Hint: Select "New" from the "File" menu or press "Control+N").

Set the audio format to be "MP3 64 kbps Mono" and complete the "Book Information" with fictional information of your choice. Leave the "Identifier" element empty for now.

Now exit the PRS software and re-launch it. At the opening dialogue box, select to open a project and select the project that you just created. You should see that this project has been selected automatically. PRS always assumes that you want to continue working on the last used project.

c. Opening a finished book from CD. If you feel happy opening existing projects, try opening a finished DAISY book from CD. This is very similar to opening an existing project except that you have to locate a file called "NCC.HTML" or "NCC.HTM". You will also be required to specify a new project name because the only way to edit an existing DAISY book is to copy the information onto the hard drive and create a new project. Information on a finalised CDR cannot be modified.

Try to open the finished book which is located in the "PRS\Sample Projects\Samples\DistributionCD\AfterBuild" folder on your sample CD. When prompted to give this a new project name, give it the name "TestProject2". Remember to set the "Files of Type" setting in the "Open" dialogue box to the correct type of file).

If you had difficulty with any of the tasks, try reading Chapter 7 again.

Exercise 3 - Playing and navigating in projects
This exercise is all about navigating around a PRS project. First of all, open the project called "TestProject2" which you created in the previous exercise. This should be located in your default folder. Once you have opened this project, try the following tasks:

a. Try switching from the Section List to the Phrase List. Examine how the Phrase List changes according to which section is highlighted. (Hint: Try using the "Tab" key).

b. Use your arrow keys to navigate up and down on the Section List and the Phrase List, listening to what is spoken as you move. Try to locate the section that begins with the words "4.1 Competitions". Count how many phrases are in this section of the project (the answer should be 8).

c. Try moving to the start of the project and start listening to the project in continuous play mode. Periodically stop the playback and then re-start it. (Hint: "F5" to start and "Spacebar" to stop).

d. Adjust the playback speed and volume using the relevant function keys. (Hint: "F3" for volume and "F6" for speed. Remember that "Shift" with these keys reduces the volume or speed).

e. Use the heading search facility to find the heading containing the word "Competent". This should take you to the "Any Other Competent Business" section. Remember to press "Escape" to exit from the search facility after finding the section.

f. This project has been coded with page, group and mark codes. Use the relevant navigation keys to move around the document to find these codes. Try to find out how many pages are in this project. The group code has been used to indicate the items on the Treasurer's summary of the income and expenditure. Use the group codes to find how much money is still due in membership fees. How many marks has the producer of the project left in this title? (Hint: If you can't remember the keyboard commands for these navigation items, look on the "Move" drop down menu).

You should find 3 page codes and the outstanding membership fees come to 150 pounds. There are 4 marks coded into this project.

Also note that the phrase which mentioned the outstanding membership fees is coded with both the page and group codes.

g. Try using the event jump command to navigate backwards and forwards through the project. Remember that an event can be any of the following: the first phrase in a section, a phrase marked with a page code and a page marked with a group code. Phrases coded with the mark code do not count as events.

If you had difficulty with any of the tasks, try reading Chapter 8 again.

Exercise 4 - Recording
In this exercise you will try out some of the basic recording features to create your own first project. However, before you start recording, there are a few checks to carry out.

a. Ensure that you have connected a microphone to the correct socket on your sound card. Also check that the Windows Volume Controls are set correctly for accepting audio input from the microphone. If you are not sure of how to do this, you should seek help from the Windows Help system.

b. Open the project you created earlier called "TestProject1". This should still be an empty project with no recorded audio.

c. Now set PRS to accept input from the microphone. (Hint: Try the "Selection of the Recording Volume Control" option on the "Control" menu). This should be set to "Microphone".

d. Before recording it is usually sensible to check out the available resources. Check what available resources you currently have on your system. (Hint: Use the "Storage Information" option on the "Tool" menu). Remember to OK the dialogue box when you have reviewed the data.

e. Now set up the "Recording Function" dialogue box with the following settings: Pause time=0.3 seconds, Noise level=Normal, Section pause time=Nothing, Create a new audio file=Yes, Time to stop recording=Nothing, Record speed=Normal speed and Remove DC Offset=Off . (Hint: Use the "Recording" option on the "Option" drop down menu).

f. Set your PRS software to be in "Overwrite" mode. (Hint: Try using the "F7" key).

g. Ensure that your microphone is turned on and set the software into "Test Recording" mode. Check that your recording level is in an acceptable range and then start recording. (Hint: Use "F8" to start the process and "F4" key to adjust the recording volume). Try to record about 3 or 4 minutes of audio. You may wish to read from a document or book. As you record new audio, you should see the phrase splitting working. This will be clear from the lower section of the main screen as the Phrase List starts to grow. When you have recorded a reasonable section of audio, stop recording (Hint: Use "Spacebar").

h. Check through your new project and observe how the phrase detection process has worked. If the phrases are very short, you probably need to increase the phrase pause time. If the phrases are very long, you may need to reduce it.

i. Make any adjustments that you think might be necessary to the pause time in the "Recording Function" dialogue box. Move your highlight to a phrase somewhere in the middle of your recording. Choose a new piece of text to record and select "Punch in" recording mode. Press "F8" to bring up the Punch in dialogue box. Leave this set to "Nothing" and press "Enter". You should now be in "Test Recording" mode - adjust the recording level to suit. Press "F8" again to start recording and read some of your new piece of text. Again the phrases in the new recording should start to appear on the Phrase List. Stop recording after a minute or two.

j. Try navigating through your project. You should observe that the new audio has been entered into the middle of the original recording.

If you had difficulty with any of the tasks, try reading Chapter 9 again.

Exercise 5 - Editing projects
This exercise is to get you used to manipulating sections and phrases in a PRS project. Remember that much of the editing is very similar to word processing in terms of selecting and some of the basic commands like cut, copy, paste and undo. Initially we will use the project that you created in Exercise 4 so do not worry about making mistakes, as the project is not important and was created to be used for experimentation.

a. First, spend some time moving around the project and observe how the phrase detection has worked. It is always useful to get an idea of how well this has worked in a project because, particularly for short documents, it is sometimes easier to re-record the project rather than spend a relatively long time editing it. For the purposes of this exercise, we will assume that it has worked reasonably well.

b. Try to select individual phrases and use the cut, copy and paste commands to move phrases around the project or delete them entirely. Try repeating these commands for multiple phrases. (Hint: Select multiple phrases by holding down "Shift" whilst pressing "Up" or "Down" Arrow keys).

c. Work your way through the Phrase List and create new sections at parts of the recording where you think it might be appropriate to have a new section start. This might be the start of a new paragraph or heading in the original document. If you do not think that there are any obvious splitting positions, just choose some phrases and create a new section at that location. (Hint: Use the "Control+Q" command and remember that you cannot create a new section if you are on the first phrase in the current section). Try to create around 5 sections in your project.

d. Now use the cut, copy and paste commands on the newly created sections. Observe how similar this process is to working with phrases.

e. Having made a few edits, try undoing some of these. (Hint: Use "Control+Z" and remember you can undo the last 10 edits).

f. Select a number of phrases or sections and try to join them together. (Hint: Use "Control+J" in both cases). Check that the sections or phrases have joined correctly by playing them.

g. Try to find a phrase which appears to be longer than you would like. Split this phrase into 2 phrases at a sensible location. (Hint: Use "Control+P" followed by your "Left" and "Right" Arrow keys). Try to observe how the position in the phrase can be moved backwards or forwards through the phrase and how the phrase will play from that point onwards. Remember to press "Enter" when you think you have selected the correct location for the split.

h. Insert a new blank section into the Section List at a position of your choice. (Hint: Use "Shift+Insert"). Record some new audio into this section using "Overwrite" mode.

i. For the next part of this exercise, re-load the "TestProject2" project that you saved earlier. On the Section List, select the section called "3. Reports from the Committee". Press "Enter" to view the section properties dialogue box. Tab around this box to see what the level and heading text is for this section. In this case, you should see that the level is Level 2 and the heading text is "Reports from the Committee". Move to the next section by pressing "Alt+Right Arrow" and observe the same information for this section. This time the level is Level 3 and the heading text is "President's Report". Move to other sections and check the properties. Remember that you can press "F12" or "F9" to hear the section properties spoken by the Voice Guidance system.

j. Use the page or group jump command to move to he phrase "Memberships still due 150 pounds". Examine the phrase properties of this phrase. You should observe that both the "Page" and "Group" options are selected. Try unchecking these 2 check boxes and press "Enter". Move to the top of the recording and try to navigate back to this phrase using the page or group jump commands. Neither of these should now work because the codings have been removed.

k. To reset these 2 codes, navigate to the "Treasurer's Report" on the Section List and then switch to the Phrase List. Move down the list until you find the phrase called "Memberships still due 150 pounds". Re-apply the page and group codes by pressing "P" and "G" respectively. You should now be able to use the page and group jump commands once again. Also try pressing "F12" or "F9" to hear the Voice Guidance read the properties for the phrase.

l. In order to demonstrate the simplicity of removing all page and group codes from the entire project, go ahead and do this now. (Hint: Use the "Delete all pages" and "Delete all groups" options from the "Edit" menu). Verify that this has worked after carrying out both commands.

m. If you are happy that this worked properly, undo both of these commands to return the page and group codes to the project.

n. Add comments to 3 sections of your choice. Do not worry about the relevance of the comment text as long as it is recognisable. (Hint: Do this in the section properties dialogue box for each section). Check that you have added the text correctly by reviewing the section properties after entering the text.

o. Remove all the comment text from the project using a single command. (Hint: Use the "Delete all comments" option from the "Edit" drop down menu.

If you had difficulty with any of the tasks, try reading Chapter 10 again.

Exercise 6 - Working with Tables of Contents
This exercise is to give you the chance to see the advantages of importing a Table of Contents into a PRS project rather than editing the section properties manually. A number of sample Tables of Contents have been supplied in the folder called "PRS\Sample Projects\TablesOfContents" on the "PTR1 User's Guide" CD. The 3 files are all called "CommitteeMinutes" but have different file name extensions according to the formats of the files.

a. Load the project called "BeforeBuild" from the "PTR1 User's Guide" CD. Observe that this project has only the default section properties for all sections. All sections are set to Level 1 and the heading text for all sections is "Heading". This is not particularly useful information. Editing a larger project manually would take some time.

b. Move to the top of the project and highlight the first section. Now use the "ToC Import" feature to import the "CSV" format file from the "PRS\Sample Projects\TablesOfContents" folder on the "PTR1 User's Guide" CD. (Hint: Use the "ToC Import" option on the "Tool" menu). Observe the change in the section property information and how quickly the import process worked.

c. Use Windows Explorer to browse to the "TablesOfContents" folder and examine the contents of the 3 different files. You should observe that they all have the heading text information but the ".HTML" and ".CSV" format files are able to store other information as well.

d. Create a brand new project and call it "TestProject3". Do not enter any book information when the dialogue box appears, simply press the "Enter" key to bypass it at this time. Before any audio is included in the project, try using the "ToC Import" feature to import the ".HTML" version of the Table of Contents. You should observe that this process automatically creates empty sections ready to record the audio into. In addition to creating the required number of sections, the level and heading text information is also created. At this stage you would then have to record and edit the audio and modify the book information. Remember that, if the ".HTML" file is an "NCC.HTML" file, some or all of the book information will have been imported at the same time. Observe the book information that now exists and you will see that the project title and most of the other book information items have been entered automatically.

These short exercises will have shown you the benefits of using the "ToC Import" feature of the software. As mentioned in the manual, which method used will depend on the circumstances of the project.

If you had difficulty with any of the tasks, try reading Chapter 11 again.

Exercise 7 - Building the book and CD writing
This exercise will briefly look at the finishing of the book and writing the project to CD. If you wish to do all these exercises, you will require to have some blank CDR or CDRW disks available.

a. Use Windows Explorer to examine the files in the project folder for the "TestProject2". You should observe that there is no "NCC.HTML" file and probably no smile (.SMIL) files.

b. Load the "TestProject2" project, and run the "Build Book" routine from the "Tool" menu. Re-examine the project folder and several extra files will have appeared. Essentially this means that the folder now contains files that are required for the finished project and the files that were necessary during the creation process.

c. Place a blank disk in the drive you selected as your default drive in Exercise 1. You need to do this before continuing with the CD writing process. If a CD is not found in the designated drive, an "Unknown error" error message will appear. Select the "CD Write" option from the "Tool" drop down menu. Use the dialogue box which appears to set the following: Writing speed=4 times, Project purpose=Master project, Last session=Valid and Post editing by PTR1=Off.

d. Having set the correct values, press the "OK" button to accept the CD writing options. When the writing process is complete, observe the files that are on the disk. You should note 1 file and one folder. The folder should contain all your normal project files, including both the temporary files and the final book files. This is because the CD was set to be a Master Project CD. This will allow future editing of the project by the PRS software. The second item will be a file called "DISCINFO.HTML". This file is used to give information to DAISY players about the structure of the books in the folder. When there is more than one book, this file stores information on all the books thus acting as a kind of catalogue file.

e. Before writing another copy of the same project to the CD, use the Book Information dialogue to change the title of the project. Perhaps call it "Second attempt" or something similar, but certainly different than the existing title. e. Run the "Build Book" process again.

f. Now call up the CD Write dialogue again and set the options as follows: Writing speed=4 times, Project purpose= Distribution CD, Last session=Valid and Post editing by PTR1=Off. Go ahead and run the CD writing routine. By choosing to create a Distribution CD, the intention is that end users do not have access to all the files that would be required to immediately edit the file with the PRS software. It could still be edited but would have to be imported using the "DAISY Import" feature before this could happen. When the CD writing is complete, again examine the contents of the newly created folder and the "DISCINFO.HTML" file. This time the project folder should have no intermediate files as there were in the Master project folder. The "DISCINFO.HTML" file should now show a listing for the project with the old name and the new name. The 2 books will be listed alphabetically so do not be too concerned if the second book is listed before the first one.

This exercise should have given you a chance to experiment with some of the processes required to create your final CD.

If you had difficulty with any of the tasks, try reading Chapter 12 and Chapter 13 again.

Exercise 8 - Some advanced features
For the more advanced features of the PRS software, detailed exercises have not been supplied. However, some ideas of things to try are given below:

a. DAISY Import - Try importing several copies of the finished books into a single new project. Call this project "TestProject4". Use the "DAISY Import" feature to achieve this. Use either the "PRS\Sample Projects\Samples\DistributionCD" folder or the "PRS\Sample Projects\Samples\MasterCD" folder for your source books.

When setting up the project initially, set the recording format to be MP3 32 kbps Mono. When running the import, set the audio conversion to be "On".

b. Audio Import - Try importing a small quantity of audio files using the "Audio Import" feature. Create a new project called "TestProject5" for this purpose. You could also try importing more than one file at a time by selecting multiple files prior to running the import.

c. Audio Export - Run the "Audio Export" process to change the recorded format to a different one. You will be asked to specify a new folder name during this process. Call the new project "TestProject6".

d. Text Import - In the "PRS\Sample Projects\Documents" folder on the "PTR1 User's Guide" CD there are a number of documents in ".TXT" format. Try using one of these files to run the "Text Import" function of the software. You may need to experiment with the settings for the "Pause time" and the speed of the chosen TTS engine to try to get the phrase detection working well. Because a synthesizer is very regimented in the way it speaks, the results can be excellent. When prompted to do so, name the new project "TestProject7".

On the "PTR1 User's Guide" CD, in the folder called "PRS\Sample Projects\Samples\Synthesized", there is an example of a project which was created using the "Text Import" feature. Very little editing was required to this project so compare your results with this one.

If you had difficulty with any of the tasks, try reading Chapter 14 again.

